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50002227B_CN 第2页

Microchip 位于美国亚利桑那州 Chandler 和 Tempe 与位于俄勒冈州
Gresham的全球总部、设计和晶圆生产厂及位于美国加利福尼亚州和印
度的设计中心均通过了 ISO/TS-16949:2009 认证。 Microchip 的 PIC®

MCU 与 dsPIC® DSC、KEELOQ® 跳码器件、串行 EEPROM、单片机外
设、非易失性存储器和模拟产品严格遵守公司的质量体系流程。此外，
Microchip 在开发系统的设计和生产方面的质量体系也已通过了 ISO
9001:2000 认证。

QUALITY MANAGEMENT  SYSTEM 
CERTIFIED BY DNV 

== ISO/TS 16949 == 
商标

Microchip 的名称和徽标组合、 Microchip 徽标、 AnyRate、
dsPIC、FlashFlex、flexPWR、Heldo、JukeBlox、KeeLoq、
KeeLoq 徽标、 Kleer、 LANCheck、 LINK MD、 MediaLB、
MOST、MOST 徽标、MPLAB、OptoLyzer、PIC、PICSTART、
PIC32 徽标、 RightTouch、 SpyNIC、 SST、 SST 徽标、

SuperFlash 及 UNI/O 均为 Microchip Technology Inc. 在美国
和其他国家或地区的注册商标。

ClockWorks、 The Embedded Control Solutions Company、
ETHERSYNCH、 Hyper Speed Control、 HyperLight Load、
IntelliMOS、 mTouch、 Precision Edge 和 QUIET-WIRE 均为
Microchip Technology Inc. 在美国的注册商标。

Analog-for-the-Digital Age、Any Capacitor、AnyIn、AnyOut、
BodyCom、chipKIT、chipKIT 徽标、CodeGuard、dsPICDEM、

dsPICDEM.net、Dynamic Average Matching、DAM、ECAN、

EtherGREEN、 In-Circuit Serial Programming、 ICSP、 Inter-
Chip Connectivity、JitterBlocker、KleerNet、KleerNet 徽标、

MiWi、motorBench、MPASM、MPF、MPLAB Certified 徽标、
MPLIB、MPLINK、MultiTRAK、NetDetach、Omniscient Code
Generation、 PICDEM、 PICDEM.net、 PICkit、 PICtail、
PureSilicon、RightTouch 徽标、REAL ICE、Ripple Blocker、
Serial Quad I/O、SQI、SuperSwitcher、SuperSwitcher II、Total
Endurance、TSHARC、USBCheck、VariSense、ViewSpan、
WiperLock、Wireless DNA和ZENA均为Microchip Technology
Inc. 在美国和其他国家或地区的商标。

SQTP 为 Microchip Technology Inc. 在美国的服务标记。

Silicon Storage Technology为Microchip Technology Inc.在除
美国外的国家或地区的注册商标。

GestIC 为 Microchip Technology Inc. 的子公司 Microchip
Technology Germany II GmbH & Co. & KG 在除美国外的国家

或地区的注册商标。

在此提及的所有其他商标均为各持有公司所有。

© 2016, Microchip Technology Inc. 版权所有。

ISBN：978-1-5224-0186-5
 2016 Microchip Technology Inc.



®
MPLAB  IPE用户指南

目录
前言 ................................................................................................................................. 5

第1章 IPE应用程序概述

1.1 IPE定义 .......................................................................................................... 9
1.2 软件安装要求 .................................................................................................. 9
1.3 支持的编程工具 ............................................................................................ 10
1.4 IPE模式 ........................................................................................................ 10

第2章 常规设置

2.1 简介 .............................................................................................................. 13
2.2 启动 IPE应用程序 ......................................................................................... 13
2.3 设置编程器 ................................................................................................... 14
2.4 高级模式登录 ................................................................................................ 17
2.5 高级模式设置 ................................................................................................ 18
2.6 创建桌面快捷方式 ......................................................................................... 28

第3章 IPE参考

3.1 IPE主窗口 .................................................................................................... 31
3.2 File菜单 ........................................................................................................ 33
3.3 View菜单 ...................................................................................................... 34
3.4 Settings菜单 ................................................................................................. 39
3.5 Help菜单 ...................................................................................................... 40

附录A 版本历史

支持 ............................................................................................................................... 43

索引 ............................................................................................................................... 45

全球销售及服务网点 ...................................................................................................... 48
 2016 Microchip Technology Inc. DS50002227B_CN 第3页



MPLAB® IPE用户指南
注：
DS50002227B_CN 第4页  2016 Microchip Technology Inc.



®
MPLAB  IPE用户指南

前言
简介

本章包含使用MPLAB®集成编程环境（Integrated Programming Environment，IPE）
前需要了解的一般信息。内容包括：

• 文档编排

• 本指南使用的约定

• 推荐读物

文档编排

本文档介绍了如何使用 IPE作为编程工具来编程器件。文档内容编排如下：

• 第1章“IPE应用程序概述”——定义IPE，提供软件安装要求和升级步骤，列出支
持的工具并提供功能矩阵。

• 第2章“常规设置” ——讨论应用程序的启动和设置过程并提供“高级模式”的登
录和选项信息。

• 第3章“IPE参考”——提供菜单项的参考信息。

客户须知

所有文档均会过时，本文档也不例外。 Microchip 的工具和文档将不断演变以满足客户的需求，因此
实际使用中有些对话框和 / 或工具说明可能与本文档所述之内容有所不同。请访问我们的网站
（www.microchip.com）获取最新文档。

文档均标记有 “DS”编号。该编号出现在每页底部的页码之前。 DS 编号的命名约定为
“DSXXXXXXXXA_CN”，其中 “XXXXXXXX”为文档编号，“A”为文档版本。

欲了解开发工具的最新信息，请参考 MPLAB® IDE 在线帮助。从 Help （帮助）菜单选择 Topics
（主题），打开现有在线帮助文件列表。
 2016 Microchip Technology Inc. DS50002227B_CN 第5页
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本指南使用的约定

本指南采用以下文档约定：

文档约定

说明 表示 示例

Arial 字体：

斜体字 参考书目 MPLAB® IDE User's Guide

需强调的文字 ……为仅有的编译器 ……

首字母大写 窗口 Output 窗口

对话框 Settings 对话框

菜单选择 选择 Enable Programmer

引用 窗口或对话框中的字段名 “Save project before build”

带右尖括号且有下划线的斜体
文字

菜单路径 File>Save

粗体字 对话框按钮 单击 OK

选项卡 单击 Power 选项卡

N‘Rnnnn verilog 格式的数字，其中 N
为总位数， R 为基数， n 为
其中一位。

4‘b0010， 2‘hF1

尖括号 < > 括起的文字 键盘上的按键 按下 <Enter>， <F1>

Courier New 字体：

常规 Courier New 源代码示例 #define START

文件名 autoexec.bat

文件路径 c:\mcc18\h

关键字 _asm， _endasm， static

命令行选项 -Opa+，-Opa-

二进制位值 0， 1

常量 0xFF， ‘A’

斜体 Courier New 可变参数 file.o， 其中 file可以是任
一有效文件名

方括号 [ ] 可选参数 mcc18 [选项] file [选项]

花括号和竖线： { | } 选择互斥参数； “或”选择 errorlevel {0|1}

省略号 ... 代替重复文字 var_name [, 
var_name...]

表示由用户提供的代码 void main (void)
{ ...
}

DS50002227B_CN 第6页  2016 Microchip Technology Inc.
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推荐读物

本用户指南介绍了如何使用 IPE。下面列出了其他有用的文档。以下Microchip文档均
已提供，并建议读者作为补充参考材料。

Processor Extension Pak and Header Specification（DS51292）

此小册子介绍了如何安装和使用调试头。通过特殊 -ICE器件版本使用调试头来更好地
调试所选器件，而无需占用额外的引脚和资源。另请参见调试头在线帮助文件。

Transition Socket Specification（DS51194）

可参考此文档获取有关适用于调试头的转换插座的信息。
 2016 Microchip Technology Inc. DS50002227B_CN 第7页
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第1章 IPE应用程序概述
1.1 IPE定义

MPLAB集成编程环境（IPE）是一款提供了简单界面来快速访问编程器关键功能的软件
应用程序。IPE为生产编程提供了安全的编程环境。

IPE使用MPLAB X IDE框架、Microchip调试器（Microchip Debugger，MDB）数据库、
硬件工具接口和相应的驱动程序来提供适用于所有Microchip编程器的编程功能。

1.2 软件安装要求

必须在您的PC上安装 IPE应用程序。在MPLAB X IDE的安装过程中，选中相应的复选
框即可安装IPE应用程序（见图1-1）。但要使用IPE应用程序，您也可无需安装MPLAB
X IDE，您可能需要参考MPLAB X IDE在线帮助来了解其他信息。

图1-1： SELECT PROGRAMS（选择程序）对话框

有关最新版本兼容信息，请参见 IPE版本说明。

软件安装完成后，通过桌面上或开始菜单中的MPLAB IPE图标即可访问IPE应用程序。

注： 必须以“管理员”身份运行 IPE才能使所有功能正常工作。
 2016 Microchip Technology Inc. DS50002227B_CN 第9页
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1.3 支持的编程工具

以下编程工具可与 IPE配合使用：

• MPLAB ICD 3在线调试器——建议用于生产编程

• MPLAB PICkit™ 3调试器 /编程器——仅用于开发编程

• MPLAB PM3编程器——建议用于生产编程

• MPLAB REAL ICE™仿真器——建议用于生产编程

• 许可的PKOB入门工具包——建议仅用于开发编程

1.4 IPE模式

1.4.1 模式

IPE应用程序有两种工作模式：

1. 生产模式——您可以在该模式下执行生产编程操作。默认情况下，IPE启动时处
于生产模式。生产模式的功能通过高级模式菜单来设置，此菜单将在本文档的
第2.5.6节“Production Mode”中讨论。

2. 高级模式——提供功能丰富的GUI界面，您可以在该模式下查看和更改编程操作
的设置以及为生产编程设置安全环境。要使能高级模式，请参见第2.3节“设置
编程器”。

1.4.2 功能矩阵

以下矩阵给出了生产模式下可访问的默认功能。

但在高级模式下，可更改生产模式的默认行为，并且可由获得授权的人员自行添加或
删除相应功能。

注： 必须以“管理员”身份运行 IPE才能使所有功能正常工作。

表1-1： 功能矩阵

功能 说明
生产模式下的

默认设置

Import Hex file（导入十六进制文件） 加载十六进制文件 开启

Import Environment（导入环境） 加载环境文件 关闭

Import SQTP file（导入SQTP文件） 加载预编译的SQTPSM文件 关闭

Export Hex file（导出十六进制文件） 将所有存储器内容保存到十六进制文件 关闭

Program（编程） 连接硬件工具并执行编程操作 开启

Erase（擦除） 擦除器件 开启

Verify（校验） 针对 IPE的存储器内容校验器件 开启

Blank Check（空白检查） 检查器件是否空白 开启

Read（读取） 读取器件并将读取的内容填充到存储器中 开启

存储器视图

Program Memory（程序存储器） 显示程序存储器的内容 关闭

Auxiliary Memory（辅助存储器） 显示辅助存储器的内容 关闭

Config Memory（配置存储器） 显示配置存储器的内容 关闭

Flash Data（闪存数据） 显示闪存数据存储器的内容 关闭
DS50002227B_CN 第10页  2016 Microchip Technology Inc.
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User IDs（用户 ID） 显示用户 ID存储器的内容 关闭

EEPROM 显示数据存储器的内容 关闭

存储器编辑

Program Memory（程序存储器） 可以编辑程序存储器的内容 关闭

Auxiliary Memory（辅助存储器） 可以编辑辅助存储器的内容 关闭

Flash Data Memory（闪存数据存储器） 可以编辑闪存数据存储器的内容 关闭

Config Memory（配置存储器） 可以编辑配置存储器的内容 关闭

EEPROM 可以编辑数据存储器的内容 关闭

User IDs（用户 ID） 可以编辑用户 ID存储器的内容 关闭

Save Environment（保存环境） 创建或改写环境 关闭

View Memory Settings（查看存储器设置） 查看存储器的范围 开启

Edit Memory Settings（编辑存储器设置） 更改存储器的范围 关闭

View Voltage Settings（查看电压设置） 查看电压值 开启

Edit Voltage Settings（编辑电压设置） 更改电压值 关闭

Create SQTP（创建SQTP） 生成SQTP文件 关闭

Manual Download Firmware（手动下载固件） 选择固件并将其下载到硬件工具中 开启

Auto Download Firmware（自动下载固件） 连接工具后便会下载系统中的最新固件 开启

Erase All Before Program（编程之前擦除
全部）

编程之前擦除器件
关闭

表1-1： 功能矩阵（续）

功能 说明
生产模式下的

默认设置
 2016 Microchip Technology Inc. DS50002227B_CN 第11页
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第2章 常规设置
2.1 简介

本章将讨论使用 IPE的入门信息。

• 启动 IPE应用程序

• 设置编程器

• 高级模式登录

• 高级模式设置

• 创建桌面快捷方式

2.2 启动 IPE应用程序

2.2.1 启动 IPE

安装软件后，双击桌面上的MPLAB IPE应用程序图标。IPE主窗口随即打开。

图2-1： IPE主窗口

2.2.2 IPE的多个实例

如果您需要使用IPE的多个实例，请参见MPLAB X IDE帮助。打开MPLAB X IDE，转到
Help>Tool Help Contents>MPLAB X IDE Help（帮助>工具帮助内容>MPLAB X IDE帮
助），导航到“Before You Begin”（开始之前）部分，然后导航到“Launch Multiple
Instances of the IDE”（启动 IDE的多个实例）。按照说明进行操作并应用于 IPE。
 2016 Microchip Technology Inc. DS50002227B_CN 第13页
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2.3 设置编程器

要编程器件，可以使用任意一款支持的工具（见第1.3节“支持的编程工具”）。有关
编程器件的信息，请参见所选工具（例如，MPLAB ICD 3和PICkit 3等）的在线帮助。

1. 使用Family（系列）下拉菜单选择您想要编程的器件系列，然后使用Device（器
件）下拉菜单选择器件。或者，使用Device下拉菜单直接选择器件。

2. 单击Apply（应用）将IPE配置为使用当前器件（例如，存储器视图和校验和）。

3. 将开发工具与PC相连。连接适当的目标板、器件和电源。有关连接目标板等的其
他说明和相关信息，请参见工具的在线帮助。

4. 使用Tool（工具）下拉菜单选择要使用的工具。如果PC上连接有多个开发工具，
请选择您要使用的那个工具（见下图）。

注： 必须以“管理员”身份运行 IPE才能使所有功能正常工作。

注： 从Family菜单中选择Recently Used（最近使用）选项时，Device菜单中会列
出最近使用的10个器件。

注： 工具名称前面的感叹号（如下图所示）表示需要更新USB驱动程序。使用
PICkit 3时不会发生这种情况。但是，使用MPLAB ICD 3、MPLAB PM3和
REAL ICE时可能需要更新USB驱动程序。

欲了解有关安装用于Microsoft Windows®的正确USB驱动程序的信息，
请启动MPLAB X IDE，然后单击MPLAB IDE v8 Users - IMPORTANT
（MPLAB IDE v8用户——重要信息）链接，该链接位于Learn & Discover
（了解和发现）选项卡的Start（开始）页面。按照说明安装驱动程序，然
后返回 IPE。
DS50002227B_CN 第14页  2016 Microchip Technology Inc.
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图2-2： 选择工具

5. 单击Connect（连接）按钮（在工具名称旁边），使 IPE与工具建立连接。

图2-3： 连接工具

6. 连接好工具后，与该工具相关的任何消息或错误都将显示在Output（输出）窗口
中，如图2-4所示。
 2016 Microchip Technology Inc. DS50002227B_CN 第15页
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图2-4： OUTPUT窗口

7. 成功连接工具后，继续按照第3章“IPE参考”使用 IPE编程器件。
DS50002227B_CN 第16页  2016 Microchip Technology Inc.
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2.4 高级模式登录

通常情况下，会授权相关人员创建用于器件和工具的生产设置。要输入这些设置，需登
录到高级模式。

1. 选择Settings>Advanced Mode（设置>高级模式），打开高级模式登录对话框。
密码区分大小写。键入默认密码microchip，然后单击Log on（登录）。

图2-5： 高级模式登录

首次登录后如要更改密码，请单击Change Password（更改密码）。

如果忘记新密码，则必须卸载 IPE，并删除 ipe.key文件（位于 IPE安装目录中）以删除
IPE中之前完成的所有设置，然后重新安装 IPE，以默认密码microchip开始使用。

图2-6： CHANGE PASSWORD对话框

注： 必须以“管理员”身份运行 IPE才能使所有功能正常工作。
 2016 Microchip Technology Inc. DS50002227B_CN 第17页
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2.5 高级模式设置

高级模式设置必须由经过授权的相关人员操作。通过在这些对话框中选择部分设置，生
产专员可从 IPE菜单栏中的Settings（设置）菜单查看和控制某些命令。

2.5.1 Operate

通过密码验证并登录到高级模式后，Operate（操作）视图中将打开一个对话框。此显
示画面与主显示画面类似，只是在窗口的左侧增加了选项按钮。

图2-7：  高级模式，OPERATE对话框
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常规设置
2.5.2 Power

Power（电源）选项仅在连接工具后可用。在Advanced Mode对话框中，单击Power可
显示可用的设置。

表2-1： 电源设置

设置 说明

Voltage Settings（电压设置）：不同器件系列的电压设置将有所不同。所有设置和
参数均与MPLAB X IDE类似。

VDD 该电压是供编程器用于校验存储器的电压。此值应为指定
电路的最大电压。默认值为器件的最大电压值。

VPP 这是用于使器件进入编程模式的电压。尽管该电压取决于
器件的编程规范，但也可能发生变化。

VDD Nom（VDD标称值） 默认值取决于器件。例如，PIC32的VDD默认标称值为
3.3V。

VDD APP（VDD施加值） 这是供编程器用于校验闪存的电压。默认值为器件的标称
电压值。

Reset Voltages
（复位电压）

使电压恢复为默认设置

ICSP Options（ICSP选项）：

Low Voltage Program
（低电压编程）

该工具可用于对特定PICXXFXXX闪存器件进行低电压编
程（Low Voltage Programming，LVP）。
所选的闪存器件必须支持低电压工作，编程操作必须在
ICSP™模式下执行。

Power Target Circuit from 
Tool（通过工具为目标电
路供电）

该设置允许通过所连工具为目标电路供电。

High Voltage on MCLR
（MCLR时使用高电压）

该设置允许在主复位（MCLR）时使用高电压。
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2.5.3 Memory

在Advanced Mode对话框中，单击Memory（存储器）可显示可用的设置。用户可以
控制存储器地址以及与编程操作相关的其他参数。此窗口中的部分选项也出现在主显
示画面中，便于查看和快速访问。

注 1： MPLAB PM3编程器在 .pm3文件类型的环境中不支持保留存储器选项。

2： 如果您希望使用任何Preserve Memory选项，首先请确保您的代码不受代码保护。对于要保留的存储器，编程器
读取需要保存的存储区域，执行对器件的批量擦除，重新编程器件，再用之前保存的内容重写保留的区域。因
此，此区域不能受代码保护。

表2-2： MEMORY SETTINGS

设置 说明

Allow Tool to select memories 
and ranges（允许工具选择存储
器及范围）

选中该复选框时，编程器工具可设置存储器类型和范围。选中后，
Program Memory字段将被禁止。

Manual select（手动选择）：

• Program Memory
（程序存储器）

允许工具编程程序存储器

• Auxiliary Memory
（辅助存储器）

允许工具编程辅助存储器

• Flash Data（闪存数据） 允许工具编程闪存数据

• EEPROM 允许工具编程EEPROM

• User IDs（用户 ID） 允许工具编程用户 ID

• Boot Flash（引导闪存） 允许工具编程引导闪存

• Configuration Memory
（配置存储器）

允许工具编程配置存储器

Program Memory Range（程序存储器范围）——定义编程程序存储器时的保留存储器地址范围。

   Start Address:（起始地址：） 将进行编程的程序空间的起始地址（以十六进制表示）

   End Address:（结束地址：） 将进行编程的程序空间的结束地址（以十六进制表示）

Reset Addresses（复位地址） 将地址恢复为默认设置

Preserve Memory（保留存储器）1——定义编程时将保留的EEPROM或闪存的地址。

Preserve EEPROM on Program
（编程时保留EEPROM）2

选中该复选框时，器件不会用存储器中的任何新数据（EEPROM窗口所
示的内容）编程。器件上EEPROM存储区中的数据不会被擦除。

Preserve Flash on Program
（编程时保留闪存）2

选中该复选框时，下面程序存储器（起始地址和结束地址）字段中指定
的程序存储器范围不会用任何新数据编程。

   Start Address:2 将保留的程序空间起始地址（以十六进制表示）

   End Address:2 将保留的程序空间结束地址（以十六进制表示）

Preserve Auxiliary Memory
（保留辅助存储器）

选中该复选框时，辅助存储器不会用辅助存储器窗口中的任何新数据
编程。

Preserve ID Memory
（保留 ID存储器）

选中该复选框时，ID存储器不会用 ID存储器窗口中的任何新数据编程。
仅当器件具有用户 ID存储器时才可使用。
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2.5.4 Environment

环境可用于保存设置，以便能够将所有相同的设置重新加载到其他编程会话中。所有工
具均支持 .pen文件或 .pm3文件类型的环境。

在Advanced Mode对话框中，单击Environment（环境）可显示可用的设置。 

注： MPLAB PM3编程器在 .pm3文件类型的环境中不支持保留存储器选项。

表2-3： ENVIRONMENT SETTINGS

设置 说明

Environment Name
（环境名称）

指定的环境名称

.pm3 file（.pm3文件） 对于MPLAB® PM3，选择此类型的文件

.pen file（.pen文件） 对于MPLAB ICD 3、PICkit™ 3和REAL ICE工具，选择此
类型的文件

Description（说明） 环境说明

SQTP File（SQTP文件） 环境中使用的SQTP文件名称

Misc Files（其他文件） 环境中使用的其他文件，例如，数据手册和说明等。
可以选择多个文件。

Properties（属性） 单击此按钮可显示MPLAB PM3中SD卡的属性。

Format（格式化） 单击此按钮可格式化MPLAB PM3中的SD卡，即擦除所有
内容。

Delete（删除） 打开Delete Environment（删除环境）窗口

Copy（复制） 打开一个对话框，选择用于复制环境的源位置和目标位置

View（查看） 打开View Environment（查看环境）窗口

Save to PM3 SD Card
（保存到PM3 SD卡）

将文件保存到MPLAB PM3 SD卡的目标位置

Save to PC（保存到PC） 将文件保存到PC上的目标位置
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2.5.5 SQTP

使用序列号快速批量编程（Serial Quick Turn Programming，SQTP）可将惟一序列号
编程到每个器件中。该序列号可用作记录码、密码或 ID编号。

在Advanced Mode对话框中，单击SQTP可显示可用的设置。

表2-4： SQTP SETTINGS

设置 说明

Generation Method（生成方法）：

Random（随机） 选中此选项可为每个器件生成惟一的随机数。
另外，需在相应字段中输入起始地址、字节数以及器件数。

Pseudo Random（伪随机）
   Seed Value (Hex):
   （种子值（十六进制）：）

选中此选项可基于Seed Value字段中输入的十六进制值生成一组不重复的
伪随机数。
另外，需在相应字段中输入起始地址、字节数以及器件数。

Sequential（连续）
   Start Value (Hex):
   （起始值（十六进制）：）
   Increment (Hex):
   （增量（十六进制）：）

选中此选项可基于指定的起始值和递增量生成序列号。
另外，需在相应字段中输入起始地址、字节数以及器件数。

Start Address (Hex):
（起始地址（十六进制）：）

输入序列号的起始地址（以十六进制表示）。

Number of bytes (Dec):
（字节数（十进制）：）

输入序列号的长度（十进制）。
确保为计划用此文件编程的器件数指定了足够长的序列号。

Number of parts (Dec):
（器件数（十进制）：）

输入要用此文件编程的器件数。

Generate（生成） 单击Generate可创建SQTP（.num）文件。

Location（位置）：

Program Memory 选中此选项可将SQTP编号加载到程序存储器中。

EEPROM 选中此选项可将SQTP编号加载到EEPROM中。

Access Method（访问方法）：

RETLW 选中此选项可使用一系列RETLW（将立即数返回到W）指令，其中序列号
字节作为立即数。

Raw Data（原始数据） 选中此选项可使用原始数据。

Format for PSV
（针对PSV格式化）

如果已选中Raw Data选项，则选中Format for PSV时会对SQTP数据进行
格式化，使其与PSV（程序空间可视性）兼容。
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2.5.6 Production Mode

在Advanced Mode对话框中，单击Production Mode（生产模式）可显示可用的生产
模式设置。

经过授权的人员可使用Production Mode Settings（生产模式设置）对话框来选择生产编
程期间可用的选项。Production Mode Settings中选择的选项决定File（文件）、View
（查看）和Settings菜单中的哪些命令在生产模式下可用。

通过选中或取消选中各个设置为您的生产编程项目选择合适的设置。选中Production
Mode Settings对话框中的某个复选框后，IPE Settings（IPE设置）菜单下的对应选项
前面会显示一个勾号标记。

勾号标记表示已在高级模式下设置了某个选项。如果某项可用且带有勾号标记，则生产
专员可通过切换开关状态来控制该项。

表2-5： PRODUCTION MODE SETTINGS

设置 说明

Production Mode Settings

Allow Export Hex
（允许导出十六进制）

允许生产专员导出十六进制文件。
选中后，该选项会显示在File>Export（文件>导出）菜单下。

Allow Import Hex file
（允许导入十六进制文件）

允许生产专员导入十六进制文件。
选中后，该选项会显示在File>Import（文件>导入）菜单下。
注：如果在 IPE 中使用十六进制文件，而文件在 IPE 外使用“记事本”或
MPLAB X IDE等进行了修改，则会显示一条消息：“File modified. The loaded
hex file has been modified externally. Would you like to reload the hex file?”
（文件已被修改。加载的十六进制文件已在外部被修改。是否要重新加载十
六进制文件？）。

Allow Import Environment
（允许导入环境）

允许生产专员导入环境。选中后，该选项会显示在File>Import菜单下。

Allow Import SQTP file
（允许导入SQTP文件）

允许生产专员导入SQTP文件。
选中后，该选项会显示在File>Import菜单下。

Generate Reports
（生成报告）

可用于生成报告。
如果已选中Generate Reports，则单击Browse（浏览）可设置报告的存放
位置。

Limit the Program Count to
（将编程次数限制为）

选中后，此选项会将通过次数、失败次数和总次数限制为在相关字段中输入
的值。
这实际上会停止进一步的编程操作。
要清零主窗口中的计数，请单击Reset Counters（复位计数器）。

Allow "Verify Device ID 
before Program" under 
Settings menu（允许
Settings菜单下的“编程
之前校验器件 ID”）

在Settings菜单中激活此选项，使生产专员能够控制此选项。
此设置仅对能够执行此功能的工具（例如，MPLAB PM3）有效。

Allow "Auto Download 
Firmware" under Settings 
menu（允许Settings菜单
下的“自动下载固件”）

选中后，此选项会显示在Settings菜单中，并且可由生产专员控制。
未选中时，IPE会根据需要为工具自动下载最新固件。

Allow "Erase All before 
Program" under Settings 
menu（允许Settings菜单下
的“编程之前擦除全部”）

选中后，此选项会显示在Settings菜单中，并且可由生产专员控制。
未选中时，生产专员无法通过Settings菜单控制此选项。
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Allow "Communication" 
under Settings menu（允许
Settings菜单下的“通信”）

选中后，此选项会被使能（第3.4节“Settings菜单”），并且可由生产专员
控制。
如果使用MPLAB PM3编程器COM端口（RS-232），则必须选中此选项才
能设置合适的COM端口。

Remove Read button from 
main window（从主窗口中
移除读取按钮）

选中此选项后，会从主窗口中移除Read（读取）按钮。

Audible notification on 
successful program 
completion（编程成功完成
时发出声音通知）

选中后，此选项会在编程成功完成时发出声音。

Allow memory editing and 
filling（允许存储器编辑和
填充）

可编辑和填充存储器。
使能后，可在生产模式下通过View>Fill Memory（查看>填充存储器）选项来
访问此选项。

Display EEPROM 
checksum in the output 
window（在输出窗口中显
示EEPROM校验和）

选中后，EEPROM校验和将显示在输出窗口中。

Display imported hex 
checksum with CP=OFF
（显示CP=OFF时导入的
十六进制校验和）

选中后，不受代码保护的校验和将显示在Results（结果）区域。

Enable programming 
operations only if hex file is 
loaded（仅在加载十六进制
文件时使能编程操作）

选中后，

a) 如果未加载十六进制文件：则将禁止所有编程按钮（Program（编程）、
Read、Erase（擦除）、Verify（校验）和Blank Check（空白检查））。

b) 如果已加载十六进制文件，则将使能所有编程按钮。

Allow Memory View（允许存储器视图）

Program Memory 选中此选项后，程序存储器会显示在主窗口上的Memory View（存储器视图）
窗格中。

Auxiliary Memory 选中此选项后，辅助存储器会显示在主窗口上的Memory View窗格中。

Config Memory
（配置存储器）

选中此选项后，配置存储器会显示在主窗口上的Memory View窗格中。

Flash Data 选中此选项后，闪存会显示在主窗口上的Memory View窗格中。

User IDs 选中此选项后，用户ID会显示在主窗口上的Memory View窗格中。只有工具支
持用户 ID时，此选项才适用。

EEPROM 选中此选项后，EEPROM存储器会显示在主窗口上的Memory View窗格中。

表2-5： PRODUCTION MODE SETTINGS（续）
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2.5.7 Settings

在Advanced Mode对话框中，单击Settings（设置）可显示可用的选项（图2-8）。

图2-8： GENERAL SETTINGS（通用设置）选项
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表2-6： GENERAL SETTINGS

设置 说明

PICkit™ 3 Programming Speed
（PICkit 3编程速度）

使用滑动条调整编程速度（见图2-9）。利用此选项，可通过减慢速
度保证足够的信号电平时间，从而帮助进行故障排除。PICkit 3滑动
条将减慢 ICSP编程速度，这有助于解决因 ICSP线高负荷引起的通信
问题。Microchip建议清除 ICSP线上的所有元件。编程速度控制功能
有助于编程 ICSP线上已存在元件的电路板。

PICkit 3 Programmer To Go
（PICkit 3脱机编程）

打开PICkit 3 Programmer To Go对话框（见图2-10），显示下次使
用Programmer-To-Go功能时将应用的设置。输入PICkit 3上的映像
将使用的映像名称。单击Programmer To Go以将其激活。有关
Programmer-To-Go功能的信息，请参见《用于MPLAB® X IDE的
PICkit™ 3在线调试器 /编程器用户指南》（DS52116A_CN）。并非
所有器件上均支持此功能。
注：Programmer To Go不支持保留存储器选项。

Secure Segments（安全段）

Segments to Program
（要编程的段）

仅适用于带CodeGuard™功能的器件（例如，dsPIC33FJ12GP202
等）。受REAL ICE、MPLAB ICD 3和PICkit 3支持。
选择要编程的段：

• Full Chip Programming（全片编程）

• Boot, Secure and General Segments（引导段、安全段和通用段）

• Secure and General Segments（安全段和通用段）

• General Segment Only（仅通用段）

SQTP

Disable operations if SQTP 
values are exhausted
（SQTP值用尽时禁止操作）

选中此复选框会在指定 .num文件中的所有SQTP值用尽时禁止进一步
编程。

Program Method（编程方法） 您可以通过此选项为器件选择测试模式进入方法。能够为目标电路供
电的工具（PM3除外）均支持此功能。此设置指的是编程/读取目标器
件时施加VPP和VDD电压的顺序。

Apply VPP before VDD 
(Recommended)
（在VDD之前施加VPP

（推荐））

这是默认设置。

Apply VDD before VPP

（在VPP之前施加VDD）
建议使用此设置时要格外注意，因为它可能会引起不良影响。此选项
仅适用于通过调试工具为器件供电的情况。

Diagnostics（诊断）

Logging Level（记录级别） 设置消息记录级别。
OFF（关闭）：不记录
SEVERE（严重）：仅记录严重（错误）消息。
WARNING（警告）：仅记录警告消息。
INFO（信息）：仅记录信息消息。
CONFIG（配置）：仅记录配置信息。
FINE（部分）：记录某些模块间的通信。
FINER（较多）：记录更多模块间的通信。
FINEST（全部）：记录所有模块间的通信。

Log File（日志文件） 日志文件的路径和名称。
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图2-9： PICkit™ 3设置选项

图2-10： PICkit™ 3 Programmer To Go对话框 

2.5.8 Log out

完成设置选择后，单击Log out（注销）可保存设置、退出高级模式并返回主窗口。

Special Memory Regions（特殊存储区）

Program Calibration 
Memory（编程校准存储区）

允许编程用于保存器件校准值的寄存器。

Program User OTP
（编程用户OTP）

允许编程OTP（可一次性编程）的序列用户ID。一经编程，无法更改。

表2-6： GENERAL SETTINGS（续）

设置 说明
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2.6 创建桌面快捷方式

可以为器件、十六进制文件或环境创建桌面快捷方式。

要执行此操作：

1. 创建MPLAB IPE桌面图标副本。

2. 右键单击新的快捷方式图标，然后单击Properties（属性）。

图2-11： 右键单击菜单

3. Properties对话框随即打开。单击Shortcut（快捷方式）选项卡。

4. 在Target（目标）字段（见图2-12）中，添加将加载指定器件、十六进制文件或
环境的其他命令。将命令置于Target字段中字符串末尾“....jar”后的位置。必须
在命令前添加一个空格。命令前有一条短线。命令不区分大小写。路径必须加
引号。

开关 命令 说明

-P -P18f1220 启动 IPE后选择指定的器件。

-P,-F -P12f1501 -F"E:\12f1501.hex" 启动IPE后为指定的十六进制文件加载指
定的器件。

-BL -BL"E:\18f1220.pm3" 启动 IPE后加载指定的环境。
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图2-12： SHORTCUT选项卡

5. 单击OK（确定）。

6. 右键单击新的快捷方式图标，然后单击 Rename（重命名）。输入快捷方式的新
名称。

7. 双击新的快捷方式图标以启动IPE。指定的目标（环境和器件等）会在IPE打开时
自动加载。
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第3章 IPE参考
3.1 IPE主窗口

下图给出了 IPE的主窗口。IPE菜单栏包含以下菜单及命令：

• File菜单

• View菜单

• Settings菜单

• Help菜单

命令是否可用取决于高级模式下选择的设置。

图3-1： IPE主窗口

注： 必须以“管理员”身份运行 IPE才能使所有功能正常工作。
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表3-1： IPE主窗口字段

项目 说明

Select Device and Tool（选择器件和工具）：

• Family 按系列或最近使用的器件过滤器件

• Device 指定器件；单击Apply来选择

• Tool 指定工具；酌情单击Connect或Disconnect（断开
连接）

Results：

• Checksum（校验和） 当前存储器内容对应的器件校验和值

• Pass Count（通过次数） 详细说明编程操作的通过次数

• Fail Count（失败次数） 详细说明编程操作的失败次数

• Total Count（总次数） 编程操作的总次数

命令按钮：

• Program（Alt+F5） 编程器件

• Erase（Alt+F6） 擦除器件

• Read（Alt+F7） 读取器件

• Verify（Alt+F8） 对器件执行校验操作

• Blank Check（Alt+F9） 检查器件是否空白

其他：

Source（源） 十六进制文件的位置——单击Browse以找到文件的
位置

SQTP SQTP文件的位置——单击Browse以找到文件的位置

More/Less（更多 /更少） 显示更多或更少信息

Output选项卡 显示输出数据。
右键单击Output窗口可拆分视图并显示工具

Tool选项卡 显示特定工具的数据，即PM3、ICD 3和PICkit 3
如果已连接好工具，右键单击Output区域并选择Split
View（拆分视图）可显示Tool选项卡。

Memory View 仅在选择View>Show Memory（查看>显示存储器）时
显示
此选项显示存储器地址、器件 ID和配置存储器等
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3.2 FILE菜单

IPE菜单栏的File菜单提供了三条命令： Import（导入）、Export（导出）和Exit
（退出）。

3.2.1 File>Import

您可以使用 Import菜单项将文件导入 IPE：

1. File->Import->Hex（文件->导入->十六进制）——选择该菜单后可导入十六进制
文件（*.hex）。

2. File->Import->Environment（文件->导入->环境）——选择该菜单后可导入环境
（*.pen或 .pm3文件）。

3. File->Import->SQTP（文件->导入->SQTP）——选择该菜单后可加载SQTP文件
（*.num文件）。

3.2.2 File>Export

您可使用Export菜单项将数据从IPE导出到存储介质。默认情况下，这些命令在生产模
式下不可用。但在高级模式下，获得授权的用户可以针对生产模式更改此功能的默认
状态。

File->Export->Hex（文件->导出->十六进制）——您可以使用此命令将所有存储器内容
导出为 Intel®十六进制文件格式。

3.2.3 File>Exit

此命令用于关闭 IPE应用程序。

注： 如果在 IPE中使用十六进制文件，而文件在 IPE外使用“记事本”或MPLAB
X IDE等进行了修改，则会显示一条消息：
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3.3 VIEW菜单

下面将介绍View菜单下的命令：

• Show Memory

• Clear All Memory（清除所有存储器）

• Fill Memory

• Memory Settings（存储器设置）

• Power Settings（电源设置）

3.3.1 Show Memory

具体显示哪种存储器根据高级模式或生产模式设置确定。此命令在显示存储器和不显
示存储器之间切换。该命令前的勾号标记表示使能在位于窗口底部的Memory View窗
格中显示存储器；取消选中表示不显示存储器。
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图3-2： MEMORY VIEW窗格

可查看的存储器类型由高级模式下选择的生产设置决定。
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图3-3： 存储器类型

使能后，可编辑配置设置。从Memory View的下拉列表中选择Config Memory。使用滚动条查看Setting列。
单击要编辑的设置，随即出现一个列表，其中会显示可用于该设置的选项。单击您的选择。

请参见下图。

图3-4： 编辑配置设置
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3.3.1.1 右键单击菜单命令

Undock/Dock（取消停靠 / 停靠）——查看存储器窗口时，右键单击菜单中包含
Undock/Dock、Fill Memory和Print（打印）命令。

可通过停靠存储器窗口以在单独的窗口中查看更大区域。右键单击Memory View中的任
意值，选择Undock（见下图）。

要将取消停靠的窗口恢复为 IPE窗口，可关闭存储器窗口或右键单击并选择Dock。

图3-5： 取消停靠的存储器视图

Fill Memory ——还可通过右键单击Memory View窗口中的任意值并选择Fill Memory
来访问此对话框。

Print ——用于打印存储器窗口，右键单击Memory View窗口中的任意值并选择Print。

注：此命令将打印存储器的全部内容。因此，如果您使用较大的器件（例如PIC32），
打印输出内容可能很多。某些情况下，您可能会考虑打印到文件，而非打印机。

3.3.2 Clear All Memory

清除所有存储器视图。
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3.3.3 Fill Memory

在高级模式下使能后，在生产模式下Fill Memory命令即出现在View菜单下。

图3-6： FILL MEMORY对话框

3.3.4 Memory Settings

显示当前存储器设置。存储器设置是只读的，无法在此窗口中更改。

3.3.5 Power Settings

显示当前电源设置。

表3-2： 填充菜单选项

设置 说明

Start Address
（起始地址）

填充操作的起始地址

End Address
（结束地址）

填充操作的结束地址

Data（数据） 填充操作使用的值

Use Data as
（将数据用作）

Fill Value（填充值）——用数据值填充每个地址
Sequential Start（顺序启动）——用递增的数据值填充每个地址
Randomize（随机化）——用随机值填充每个地址

Write（写入） 将地址写入存储器视图

Close（关闭） 退出对话框
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3.4 SETTINGS菜单

3.4.1 了解Settings菜单命令

IPE菜单栏上的Settings菜单（见表3-3）包含多个可供生产人员使用的命令。其中的多
数命令可通过Advanced Mode和Production Mode对话框来访问。

菜单命令显示为有效状态（黑色）或不可用状态（灰显）。

带勾号标记的有效命令表示生产人员可控制这些设置。

不带勾号标记的有效命令表示只有经过授权的人员才能访问它们。

无论是否带勾号标记，不可用命令均表示生产人员无法控制这些设置。

* 单击连接 /断开连接按钮或执行编程操作后，才会下载固件。

表3-3： SETTINGS菜单命令

设置 说明

Advanced Mode 此命令用于打开Advanced Mode登录对话框。登录通过验证后，经过授权的人员
可进行其他设置。
更多信息，请参见“设置编程器”和“高级模式设置”。

Verify Device ID Before 
Program（编程之前校
验器件 ID）

此命令仅适用于所使用器件具有器件 ID的情况。

Erase All Before 
Program（编程
之前擦除全部）

此命令用于控制是否在编程器件前擦除其中的内容。
此命令不适用于可一次性编程（One-Time-Programmable，OTP）。使能“Erase
All Before Program”命令（选中复选框）时，在编程之前将擦除器件。
如果禁止此命令（取消选中），在编程之前不会擦除器件。

Auto Download 
Firmware（自动
下载固件）*

如果选中此命令，应用程序将验证固件是否为最新版本；必要时，将自动下载较
新版本的固件。

Manual Download 
Firmware（手动
下载固件）*

此命令用于使能手动下载固件。

Hold on Reset
（保持复位）

防止编程后运行代码

Release from Reset
（从复位释放）

移除复位并允许代码运行

Communication
（通信）

仅与MPLAB PM3编程器配合使用
此命令用于打开PM3 Communication Setting（PM3 通信设置）对话框。使用
此对话框可为COM端口或USB 端口设置通信。更多信息，请参见“PM3
Communication Setting对话框”。
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PM3 Communication Setting对话框

只有在Advanced Mode对话框和Production Mode对话框中选中Allow "Communication"
under Settings menu对应的复选框时，才能从 IPE菜单栏的Settings菜单下访问PM3
Communication Setting对话框。

使用PM3 Communication Setting对话框前，必须用合适的电缆将MPLAB PM3与PC
相连。

此对话框可用于选择MPLAB PM3编程器与 IPE之间的通信端口。

要使用MPLAB PM3上的RS-232端口，请选择COM端口选项按钮，然后使用下拉列表
选择可用的端口。必要时，单击刷新按钮查看可用的端口。单击Test（测试）按钮检
查 IPE与MPLAB PM3之间的通信。

要将USB用于通信端口，请选择USB选项按钮。

手动设置COM端口

在一些系统中，您可能需要手动设置通信端口。

在Windows系统的Start（开始）菜单中，选择Control Panel（控制面板），然后选择
System and Security（系统和安全）。在System（系统）设置中，单击Device
Manager（设备管理器）。展开Ports（端口）下拉列表，双击要使用的端口。单击
Port Settings（端口设置）选项卡，选择以下设置：

每秒位数：19200（波特率）
数据位：8
奇偶校验：None（无）
停止位：1
流控制：Hardware（硬件）

单击Advanced（高级）。取消选中Use FIFO buffers（使用FIFO缓冲区）复选框。

重启PC以使更改生效。

3.5 HELP菜单

可通过Help菜单访问在线用户指南以及了解有关编程的信息。
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附录A 版本历史
版本A（2013年12月）

本文档的初始版本。

版本B（2015年8月）

修改了第1.2节“软件安装要求”。IPE现在可独立于MPLAB X IDE进行安装。

修改了生产模式的说明。

在第2章“常规设置”中：

• 增加了有关新功能的信息：器件Family列表中的Recently Used选项以及创建桌面快
捷方式。

• 增加了有关Preserve Memory选项的信息。

• 增加了有关MPLAB PM3编程器环境文件的注。

• 在表2-5中的Allow Import Hex file选项的说明中增加了一条注。

• 在表2-5中增加了有关将MPLAB PM3编程器与Allow "Communication" under Settings
menu选项配合使用的信息。

• 在表2-6中增加了Special Memory Regions的信息。

在第3章“IPE参考”中：

• 增加了与File>Import>Hex选项有关的一条注。
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支持
简介

有关支持问题，请参见此处讨论的各项。

• 保修登记

• Microchip网站

• mymicrochip个性化通知客户服务

• 客户支持

保修登记

如果您的开发工具包中包含保修登记卡，请填写该保修登记卡并尽快寄出。寄出保修
登记卡的客户可收到新产品更新信息。可在Microchip网站上获得临时软件版本。

MICROCHIP网站

Microchip 网站 （www.microchip.com）为客户提供在线支持。客户可通过该网站方便
地获取文件和信息。只要使用常用的互联网浏览器即可访问，网站提供以下信息：

• 产品支持 —— 数据手册和勘误表、应用笔记和示例程序、设计资源、用户指南以
及硬件支持文档、最新的软件版本以及归档软件

• 一般技术支持 —— 常见问题解答 （FAQ）、技术支持请求、在线讨论组以及
Microchip 顾问计划成员名单

• Microchip 业务 —— 产品选型和订购指南、最新 Microchip 新闻稿、研讨会和活
动安排表、 Microchip 销售办事处、代理商以及工厂代表列表

myMICROCHIP个性化通知客户服务

Microchip的个人通知客户服务有助于客户了解关于所关注Microchip产品的最新信息。
注册客户可在指定产品系列或开发工具发生变更、更新、发布新版本或勘误表时，收
到电子邮件通知。

请访问http://www.microchip.com/pcn开始注册过程，并选择接收个性化通知的首选
项。页面上提供了FAQ和注册详细信息，可以通过选择上面的链接打开。
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在选择首选项时，选择“Development Systems”（开发系统）将会在列表中填入可
用的开发工具。下面列出了主要的工具类别：

• 编译器—— Microchip C编译器、汇编器、链接器及其他语言工具的最新信息。包括
所有MPLAB C编译器、所有MPLAB汇编器（包括MPASM™汇编器）、所有MPLAB
链接器（包括MPLINK™目标链接器），以及所有MPLAB库管理器（包括MPLIB™
目标库管理器）。

• 仿真器—— Microchip在线仿真器的最新信息，包括MPLAB REAL ICE在线仿真器。

• 在线调试器—— Microchip在线调试器的最新信息。其中包括MPLAB ICD 3在线调
试器和PICkit 3 Debug Express。

• MPLAB X IDE ——关于开发系统工具的Windows®集成开发环境Microchip MPLAB
X IDE的最新信息。

• 编程器—— Microchip编程器的最新信息。其中包括器件（生产）编程器（如MPLAB
REAL ICE在线仿真器）、MPLAB ICD 3在线调试器、MPLAB PM3以及PICkit 3开
发（非生产）编程器。

• 入门/演示板——包括MPLAB入门工具包电路板、PICDEM演示板以及各种其他评
估板。

客户支持

Microchip产品的用户可通过以下渠道获得帮助：

• 代理商或代表

• 当地销售办事处

• 应用工程师（FAE）

• 技术支持

客户应联系其代理商、代表或应用工程师（FAE）寻求支持。当地销售办事处也可为
客户提供帮助。本文档后附有销售办事处的联系方式。欲获得最新、最全的销售办事
处列表，请访问我们的网站。

也可通过http://www.microchip.com/support获得网上技术支持。

如果您发现本文档有任何错误或者对本文档有任何建议，请通过电子邮件联系我公司
TRC经理，电子邮件地址为CTRC@microchip.com。
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